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1. Introduction

NovaEditor is a desktop patch editor for the Novation MiniNova synthesizer. It gives you complete visual

control over every parameter of the MiniNova — from oscillator waveforms and filter routing to the

modulation matrix, vocoder, and animated performance pads — without ever diving into the MiniNova's

hardware menus.

What You Can Do

Edit patches visually — every parameter on screen with real-time MIDI feedback.

Organise up to 384 patches across three banks (A / B / C, 128 patches each).

Backup and restore the full patch library directly from / to your device.

Save and load individual patches or complete banks as .syx  files.

Assign performance tweaks — map any synth parameter to the four front-panel knobs.

Design complex modulations — 20-slot modulation matrix with two sources, animation, and 60+

destinations.

2. System Requirements & Installation

System Requirements

Minimum

macOS 10.15 Catalina or later

Windows Windows 10 (64-bit) or later



RAM 4 GB

Disk 200 MB free

MIDI USB-MIDI or class-compliant audio interface

Installation

macOS: Open the .dmg  file and drag NovaEditor to your Applications folder.

Windows: Run the .exe  installer and follow the on-screen prompts. NovaEditor installs to

%LOCALAPPDATA%\Programs\NovaEditor .

Connecting the MiniNova

1. Connect the MiniNova to your computer via the included USB cable (the MiniNova exposes a USB-

MIDI interface — no additional driver is required on macOS or Windows 10+).

2. Power on the MiniNova.

3. Launch NovaEditor.

4. In the Header, select the MiniNova in both the MIDI In and MIDI Out dropdowns, then click

Connect.

3. Getting Started

Typical Workflow

1. Connect the MiniNova (see above).

2. Click Read in the Header to pull the currently active patch off the device into the editor.

3. Tweak any parameter — changes are sent to the MiniNova in real time over MIDI.

4. Click Write to save the edited patch back to the device at the current patch slot.

5. Click Save to export the patch as a .syx  file for safe keeping.

Loading a Patch Library

1. Go to the Library tab.

2. Click Load .syx and choose a .syx  file containing up to 128 patches.

3. Patches appear in the grid. Click any patch to load it into the editor and send it to the device for

preview.

Backing Up Your Patches

1. In the Library tab, make sure the MiniNova is connected.

2. Click Backup Device. NovaEditor reads all 128 patches from the device into the active bank.

3. Use Load .syx → right-click a different bank tab to organise patches across banks A, B, and C.

4. Click Restore to Device to write the active bank back to the device.

Note: Backup and Restore require a valid license (not available in Demo mode).

4. Main Interface Overview

The NovaEditor window is divided into three zones:

┌─────────────────────────────────────────────────────────┐
│  HEADER — Patch name, MIDI I/O, bank/patch navigation   │



├─────┬───────────────────────────────────────────────────┤
│     │                                                   │
│  L  │           MAIN EDITOR AREA                        │
│  I  │   (active tab: Oscillators / Filters /            │
│  B  │    Envelopes / LFOs / Effects /                   │
│  R  │    Mod Matrix / Tweaks / Arp·Vocoder)             │
│  A  │                                                   │
│  R  │                                                   │
│  Y  │                                                   │
│     │                                                   │
├─────┴───────────────────────────────────────────────────┤
│  FOOTER — Transfer progress, updates, license status    │
└─────────────────────────────────────────────────────────┘

Tab Navigation

Eight tabs run across the top of the editor area:

Tab Icon Contents

Oscillators ⬡ Osc 1, Osc 2, Osc 3, Voice, Mixer

Filters ⌖ Filter 1, Filter 2, Routing

Envelopes ◈ All 6 envelopes simultaneously

LFOs ∿ LFO 1, LFO 2, LFO 3

Effects ✦ 5 FX slots, Global FX, 3-band EQ

Mod Matrix ⇄ 20 modulation slots

Tweaks ⊟ 8 performance knobs (2 rows)

Arp / Vocoder ♩ Arpeggiator, Vocoder, Vocal Tune, Chorder

5. Header — MIDI & Patch Controls

Patch Name

The text field on the left of the Header shows the current patch name (up to 16 characters). Click it to edit;

the name is sent to the device when you click Write.

Bank & Patch Selector

Three buttons — A, B, C — select the active bank. The arrow buttons ◀ ▶ and the number field between

them navigate through the 128 patch slots (000–127).

MIDI Setup

Control Purpose

MIDI In dropdown Selects the MIDI input port (MiniNova appears as "MiniNova MIDI" or similar)



MIDI Out dropdown Selects the MIDI output port

Connect button Opens the MIDI connection. The status pill turns green when connected.

Status pill states:

Connected (teal) — MIDI is active; edits send to device immediately.

Connecting… — Negotiating with the device.

No Device — No MIDI ports found; check USB cable and power.

MIDI Error — A communication error occurred; click Connect to retry.

Patch Operation Buttons

Button Action

⤓ Read Requests the current patch from the device. The button shows a spinner while waiting.

⬆ Write Sends the entire current patch to the device at the selected slot.

💾  Save Exports the current patch as a .syx file.

📂  Load Lib Loads a .syx file into the active bank in the Library.

Demo mode note: Read, Write, and file dump operations each consume one of the 5 allowed demo

operations. See Section 15.

6. Library — Patch Browser

The Library panel on the left side of the window (always visible regardless of the active tab) manages three

patch banks.

Banks

Click the Bank A / B / C tabs to switch banks. Each bank holds 128 patches. The tab label shows how many

patches are currently loaded, e.g. Bank A (64) .

Patch Grid

Each of the 128 slots shows a three-digit number and a patch name. Slot appearance:

Empty — dimmed, no name.

Loaded — full name visible on dark background.

Selected (highlighted) — the patch currently open in the editor.

Device current (accent highlight) — the patch the MiniNova is actively playing.

Click any loaded patch to load it into the editor and preview it on the device.

Toolbar Actions

Button Action

📂  Load .syx Opens a file picker to load a .syx file into the active bank.

⬇ Backup Device Reads all 128 patches from the device into the active bank. Requires license.



⬆ Restore to Device Writes the active bank (all 128 patches) to the device. Requires license.

✕ Clear Clears all patches from the active bank (editor content is not affected).

Right-Click Menu

Right-clicking a patch slot offers:

Load into Editor — Opens the patch in the editor without sending it to the device.

Send to Device Slot… — Opens a dialog to write this patch to a specific slot on the device (choose

bank and slot number, then click Write).

7. Oscillators

The Oscillators tab contains panels for Osc 1, Osc 2, Osc 3, Voice, and Mixer.

Oscillator Panels (Osc 1 / 2 / 3)

Each oscillator is identical in structure.

Waveform

The Waveform dropdown selects the oscillator's waveform source. The 74 available waveforms are

organised into families:

Family Examples

Basic Sine, Triangle, Sawtooth, PW (pulse width), Square

PW/Saw

blend
Saw 9:1 … Saw 1:9 (9 intermediate shapes)

Classic
BassCamp, Bass FM, EP Dull, EP Bell, Clav, DoubReed, Organ 1/2, EvilOrg, StrnMch

1/2

Digital Bell FM 1/2, DigBell 1–4, DigiPad

Wavetable Wtable 1–36

Audio In AudInL/M, AudioInR

Fine Controls

Knob Range Default Notes

WT Interp 0–127 127 Wavetable interpolation smoothness

PW/Idx 0–127 64
Pulse width (basic waves) or FM index (digital waves); centre =

50%

VSync 0–127 0 Virtual sync depth; shapes the waveform cycle

Hardness 0–127 0 Waveform hard-clip amount

Density 0–127 0 Number of detuned copies (supersaw-style)



Dens

Detune
0–127 0 Detuning spread of Density voices

Semitones 0–127 64 Coarse pitch offset; 64 = no shift

Cents 0–127 64 Fine pitch offset; 64 = no shift

Level

The large Level knob (0–127) sets the oscillator's output level fed into the Mixer. Default is 127 for Osc 1, 0

for Osc 2/3.

Voice Panel

Poly Mode

Option Behaviour

Mono One voice at a time; new note cuts previous.

Mono (AG) Mono with auto-glide when notes overlap.

Poly Full polyphony (up to 8 voices).

Poly 2 Alternate polyphony mode.

Mono 2 Mono with legato envelope retrigger.

Portamento

Porta Time (0–127) — Glide time between notes. 0 = instant.

Porta Mode — Exponential  (musical, faster near target) or Linear  (constant rate).

Pre-Glide — Pitches the note up/down (±1–3 semitones) at note-on before gliding to the true pitch.

Options: –3 st, –2 st, –1 st, Off, +1 st, +2 st.

Unison

Unison — Off / 2 / 3 / 4 Voices. Stacks detuned copies of each note.

Detune (0–127) — Spread between unison voices.

Oscillator Global Modulation

Knob Range Default Notes

Vib Depth 0–127 0 Global vibrato depth (from the mod wheel LFO)

Vib Rate 0–127 65 Global vibrato rate

Drift 0–127 0 Random pitch drift (analogue warmth)

Phase 0–127 0 Oscillator start phase (0 = free-running)

Mixer Panel

The Mixer combines the three oscillators with ring modulation and noise.



Knob Default Notes

Osc 1 127 Main oscillator level

Osc 2 0

Osc 3 0

RM 1×3 0 Ring modulation of Osc 1 × Osc 3

RM 2×3 0 Ring modulation of Osc 2 × Osc 3

Noise 0 Noise generator level

Noise Type — White, High, Band, or HiBand.

8. Filter

The Filter tab shows Filter 1, Filter 2, and routing controls.

Routing & Global Controls

Control Options Notes

Routing
Single / Series /

Parallel

Single uses only Filter 1; Series feeds F1 output into F2; Parallel

mixes both.

Balance 0–127 (centre = 64)
Mix between Filter 1 and Filter 2 in Parallel mode. Displayed as

±64.

Freq

Link
On / Off Links the Frequency knobs of both filters so they move together.

Res Link On / Off Links the Resonance knobs of both filters.

Filter Panels (Filter 1 & 2)

Each filter is identically structured. Filter 1 uses the accent colour; Filter 2 uses teal.

Type Selection

Control Options

Type Low Pass, Hi Pass, Band Pass, Band Reject, All Pass, Low Shelf, Hi Shelf, Peak EQ

Drive Mode Diode, Valve, Clipper, X-Over, Rectify, BitsDown, RateDown

Main Controls

Knob Size Default Notes

Freq Large 64 Filter cutoff/centre frequency

Resonance Large 0 Self-oscillates at high values



Drive Medium 0 Input gain into the Drive Mode circuit

Env→Freq Medium 64 Envelope (Filter Envelope) modulation depth; 64 = no mod

KBD Track Medium 0 Keyboard tracking: higher notes open the filter

Q Normalise

Toggle Q Normalise to maintain consistent volume as Resonance increases.

9. Envelopes

The Envelopes tab shows all six envelopes simultaneously in a 3 × 2 grid — no tab switching required.

Panel Colour Typical Use

Env 1 (Amp) Red/Accent Amplitude (volume) envelope

Env 2 (Filter) Teal Filter frequency modulation

Env 3 Blue General purpose modulation

Env 4 Yellow General purpose modulation

Env 5 Purple General purpose modulation

Env 6 Light red General purpose modulation

A visual ADSR curve at the top of each panel updates as you adjust the knobs.

ADSR & Delay Parameters

Knob Env 1–2 Env 3–6 Default Notes

Delay — ✓ 0 Time before the envelope starts

Attack ✓ ✓ 0 Rise time

Decay ✓ ✓ 64 Fall time from peak to sustain level

Sustain ✓ ✓ 64 Held level while key is pressed

Release ✓ ✓ 32 Fall time after key release

Modulation Parameters

Knob Default Notes

Velocity 64 How much note velocity scales the envelope depth; 64 = no velocity scaling

Sus Rate 0 Rate of sustain-level variation (LFO-style movement during sustain)

Sus Time 0 Duration of the sus-rate modulation

AD Rpt 0 Attack–Decay repeat count (0 = no repeat, plays as normal ADSR)



Trigger

Trigger toggle — When On, the envelope retriggers with each new note even in Legato/Mono mode.

Anim Trig (Animation Trigger)

Each envelope can be triggered by one of the 8 Animate pads. Options:

Value Behaviour

Off No animation trigger

A1–A8 ReTrig Re-triggers the envelope from zero when pad N is pressed

A1–A8 Trigger Triggers the envelope only while pad N is held

A1–A8 Enable Enables the envelope only while pad N is held

10. LFOs

The LFO tab shows LFO 1, LFO 2, and LFO 3 side by side.

Shape

A visual preview of the selected waveform is shown above the Shape dropdown. Available shapes:

Family Options

Standard Sine, Triangle, Sawtooth, Square, Rand S/H (random sample-and-hold), Time S/H

Piano Env PianoEnv

Sequence Seq 1–7 (step-sequenced pitch patterns)

Alternating Altern 1–8

Scale
Chromat, Chrom 16, Major, Major 7, Minor7, MinArp1, MinArp2, Diminish, DecMinor,

Minor3rd, Pedal, 4ths, 4ths x12, 1625 Maj, 1625 Min, 2511

Rate & Modulation

Knob Default Notes

Rate 64 LFO speed when Rate Sync is Off

Slew 0 Smoothing of the LFO output (reduces sharp edges)

Phase 0 Start phase offset of the LFO cycle

Delay 0 Time before the LFO reaches full depth after note-on

Rate Sync

Locks the LFO rate to MIDI clock. Available divisions range from 32nd T (triplet 32nd) through standard

values (16th, 8th, 4th, 2nd, whole) up to 64 beats. Set to Off to use the free-running Rate knob.



Mode Toggles

Toggle Behaviour

One Shot LFO runs once per note-on, then stops

Key Sync LFO restarts its cycle on every new note

Common Sync All three LFOs share a single phase (useful for polyrhythms)

Delay Trig Delay counter resets on every note-on

11. Effects

The Effects tab contains three sections: 5 FX Slots, Global FX, and a 3-band EQ.

FX Slots (1–5)

Each slot has:

Type dropdown — 14 effect types plus Bypass:

Type Description

Bypass No effect

EQ Parametric equaliser

Compressor 1 / 2 Two compressor algorithms

Distortion 1 / 2 Overdrive / bit-crush style distortion

Delay 1 / 2 Tempo-syncable delay (stereo and ping-pong)

Reverb 1 / 2 Room and hall reverb

Chorus 1–4 Ensemble / flanging / shimmer variants

Gator Rhythmic gate / volume chopper

Level knob (0–127) — Wet/send level for that slot.

Global FX

Control Default Notes

Feedback 0 Global FX feedback (delay tails, reverb tails)

Pan Pos 64 (±0) Global FX stereo position

Pan Rate 0 Auto-pan rate

Pan Depth 0 Auto-pan depth

Routing — Serial (slots in sequence) or Parallel (all run simultaneously)

Pre FX 64 Dry signal level going into FX



Post FX 64 Wet mix level out of FX

3-Band EQ

A shelving/peak EQ applied globally to the output.

Band Freq Default Level Default

Bass 0 (low shelf) 64 (0 dB)

Mid 64 64 (0 dB)

Treble 127 (high shelf) 64 (0 dB)

Each band has a Freq knob and a Level knob. Level is displayed as ±64; 64 = 0 dB (no cut/boost).

12. Modulation Matrix

The Mod Matrix tab provides 20 independent modulation slots, each routing one or two sources to a

single destination.

Slot Structure

Each row contains:

Column Options Notes

# 01–20 Slot number

Source 1 19 sources Primary modulation source

Source 2 19 sources Scales the depth of Source 1

Animation Off, A1–A8 ReTrig Enables the slot only when a pad is active

Depth –64 to +63 Positive = in-phase; negative = inverted

Destination 62 destinations Where the modulation is applied

Sources

Source Description

Direct Always-on (constant modulation)

Mod Wheel MIDI CC 1

Aftertouch Channel pressure

Expression MIDI CC 11

Velocity Note-on velocity

Keyboard Note pitch (keyboard tracking)



LFO1 +, LFO1 +/– LFO 1 unipolar / bipolar

LFO2 +, LFO2 +/– LFO 2 unipolar / bipolar

LFO3 +, LFO3 +/– LFO 3 unipolar / bipolar

Env Amp, Env Filter Amplitude / Filter envelopes

Env 3–6 Aux envelopes

AudInEnv Audio input envelope follower

Destinations (selected highlights)

Category Destinations

Pitch O1+2+3 Pitch, O1/O2/O3 Pitch individually

Oscillator O1–3 VSync, O1–3 PW/Idx, O1–3 Hard, O1–3 Level

Mixer Noise Lvl, RM13 Lvl, RM23 Lvl

Filter F1/F2 Freq, F1/F2 Res, F1/F2 Drive, F Balance

LFO LFO1/2/3 Rate

Envelope AEnv Dec, FEnv Dec

FX FX1–5 Amt, FX Feedback, FX Wet Lvl

Chorus Ch1–4 Rate/Depth/Delay/Fback (16 parameters)

Delay Dly1/2 Time, Dly1/2 Fdbk

EQ Bass/Mid/Treble Lvl and Frq (6 parameters)

Vocoder Pan Posn, Voc Shift, Voc Spred, Voc Res

Master PreFX Lvl, Pitch Shift

Tips

Setting Source 2 to Mod Wheel lets you bring in a modulation gradually with the wheel.

Animation in a mod slot + Anim Trig in an envelope = fully animated pad performance.

A Depth of 0 effectively bypasses the slot without clearing it.

13. Tweaks — Performance Knobs

The Tweaks tab maps synth parameters to the four performance knobs on the front panel of the MiniNova.

Two Rows

Row Knobs Hardware Selection

Row 1 — Tweaks 1–4 Knob 1, 2, 3, 4 Selected on device when Row 1 is active



Row 2 (FX) — Tweaks 5–8 Knob 1, 2, 3, 4 Selected on device when Row 2 (FX Tweak) is active

Row 1 uses the accent (red) colour; Row 2 uses teal.

Assigning a Tweak

Each tweak slot shows the current assignment and a Parameter dropdown with 170+ assignable

parameters, including:

Portamento Time

Oscillator levels, waveform index, pitch offsets

Mixer levels (Osc 1–3, Ring Mod, Noise)

Filter Freq, Res, Drive, Env Depth (per filter)

All six envelope ADSR values + Velocity

LFO Rate, Sync, Slew (per LFO)

FX levels, delay times, chorus parameters

Arp Gate, Swing

Mod Matrix depth slots (1–20)

Select No Assign to leave a knob unused.

14. Arp / Vocoder

This tab is divided into four panels: Arpeggiator, Vocoder, Vocal Tune, and Chorder.

14.1 Arpeggiator

The Enable toggle at the top right activates the arpeggiator.

Mode & Pattern

Control Options Notes

Mode
Up, Down, Up+Down, Up&Down, As Played, Random,

Chord, Solo
Determines note order

Pattern Pattern 1–16, User 1, User 2 Rhythmic gate pattern

Rate

Sync
36 divisions (32nd T to 64 beats)

Locks arpeggio to MIDI clock

tempo

Timing Controls

Knob Default Notes

Gate 64 Note length relative to the step (50% = staccato, 127 = legato)

Swing 64 Shuffle amount; 64 = straight, higher = laid-back feel

Length 8 Number of active steps (1–16)

Octaves 1 Range of octaves arpeggiated (1–4)

Key Latch



Toggle Key Latch to hold the arpeggio running after you release the keys.

Step Grid

Eight step toggles (1–8) enable or disable individual steps within the pattern. Disabled steps produce rests.

14.2 Vocoder

The All Max toggle sets all band levels to maximum. Freeze holds the current spectral snapshot.

Level Controls

Knob Default Notes

Level 0 Overall vocoder output level

Carrier 0 Level of the synthesiser carrier signal

Modulator 0 Level of the microphone/audio-in signal

Sibilance 127 High-frequency sibilance (S/T sounds) pass-through

Shape Controls

Knob Default Notes

Resonance 0 Resonance of the vocoder filter bank

Width 40 Stereo spread of the vocoder bands

Shift 0 Spectral shift up/down (pitch-shifts the vocoder formants)

Spread 0 Spacing between vocoder bands

Gate Controls

Knob Default Notes

Decay 0 How long band signals hold after modulator level drops

Gate Thr 0 Threshold below which the vocoder is gated off

Gate Rel 0 Release time of the gate

Hardware note: The MiniNova's built-in microphone feeds the Modulator input. An external microphone

can be connected to the Ext In socket on the rear panel for better vocal quality.

14.3 Vocal Tune

Vocal Tune applies real-time pitch correction or harmonisation to the microphone signal.

Level & Insert

Control Options Notes

Level 0–127 Vocal Tune output level



Insert Pre Filt / Post Filt / Pre FX Where in the signal chain Vocal Tune is inserted

Mode

Mode Behaviour

Off Vocal Tune bypassed

Scale Corr Corrects pitch to the nearest note of the selected scale

KB Control Pitch is forced to the note currently held on the keyboard

Pitch Raw pitch shifting only (no scale or keyboard control)

Scale (Scale Corr / KB Control modes)

Scale — Played, Chromatic, Major, Rel Minor, Har Minor, Mel Minor.

Key — C through B (12 chromatic roots).

Pitch Controls

Knob Default Notes

Shift 64 Pitch offset (64 = no shift)

Bend 64 Pitch bend range

Speed 0 Correction time; 0 = instant snap, higher = slower glide

Vibrato

Knob Default Notes

Depth 0 Vibrato depth

Rate 64 Vibrato rate

Mod Whl 0 Amount mod wheel introduces vibrato

Threshold

Threshold (0–127) — Gate threshold below which Vocal Tune is inactive.

14.4 Chorder

The Chorder adds harmony notes above the played key.

The Enable toggle activates the Chorder.

Configuration

Control Options Notes

Chord Size Off, 2, 3, 4, 5 Notes Number of simultaneous notes (including the root)

Transpose 0–127 (centre = 64) Shifts the whole chord up/down in semitones



Interval Selection

When Chord Size is 2–5, additional Interval dropdowns appear for Note 2 through Note 5. Each offers 61

values (0–60 semitones):

Common intervals: Unison (0), m2 (1), M2 (2), m3 (3), M3 (4), P4 (5), Tritone (6), P5 (7), m6 (8), M6 (9), m7

(10), M7 (11), Oct (12), and multiples up to 5 Oct (60).

Example — Major triad: Chord Size = 3 Notes, Note 2 = M3 (4), Note 3 = P5 (7).

15. Demo Mode & Licensing

Demo Mode

Without a valid license, NovaEditor runs in Demo mode. Demo mode allows 5 patch operations:

Counted operations:

Read — Request patch from device

Write — Send patch to device

Save — Export patch to file

Dump — Dump current patch to file

Non-counted (free) operations:

Editing parameters in the editor

Loading .syx  files into the Library

Browsing patches in the Library

The footer always shows the remaining operation count:

Demo — 3 ops left

Backup Device and Restore to Device are not available in Demo mode. Clicking either button shows a

prompt to activate or purchase.

When the 5 operations are exhausted, gated features are blocked until you activate.

Activating NovaEditor

Open the Activation window via any of:

Menu: File → Activation

Keyboard shortcut: ⌘T (macOS) / Ctrl+T (Windows/Linux)

Activate button in the footer

Enter your email address and serial number from your purchase receipt, then click Activate.

On success, NovaEditor connects to the license server, verifies your credentials, and unlocks all features.

The footer changes to:

Licensed (teal)

Deactivating

To move your license to another machine, open the Activation window and click Deactivate. This releases

the activation on this machine so you can activate on another.



Offline Use

NovaEditor checks the license server every 8 minutes while running. If the server is unreachable (no internet

connection), NovaEditor falls back to the local license file and continues to work normally. A valid local file is

all that is needed for offline operation.

Purchasing

Click the Buy button in the footer (or visit www.xtractpler.com) to purchase a license. After purchase you

will receive a serial number by email.

16. Keyboard Shortcuts

Shortcut Action

⌘T / Ctrl+T Open Activation window

⌘Shift+H / Ctrl+Shift+H Open this User Manual

Standard system shortcuts (Cut, Copy, Paste, Select All) work in text fields throughout the app.

17. Troubleshooting

MiniNova Not Detected

1. Check the USB cable is firmly connected at both ends.

2. Verify the MiniNova is powered on.

3. Quit and relaunch NovaEditor — MIDI ports are enumerated at startup.

4. On Windows, ensure no other application (DAW, standalone editor) has exclusive control of the MIDI

port.

Read Button Spinner Does Not Stop

The MiniNova may not have responded to the patch request.

1. Ensure you are on the correct MIDI channel (the MiniNova defaults to channel 1).

2. Try pressing a key on the MiniNova to confirm MIDI output is working.

3. Click Connect again to re-initialise the MIDI connection.

Patch Edits Not Heard on Device

Confirm the MIDI Out dropdown points to the MiniNova.

Check the MiniNova's Local Control setting. If Local is off, the device will not respond to MIDI unless

it is also receiving from NovaEditor.

Activation Error: "Invalid serial or email"

Double-check there are no leading or trailing spaces in either field.

Email address must match the one used at purchase (case-insensitive).

If the problem persists, contact support at the email address in your purchase receipt.

Activation Error: "Connection Error"

Check your internet connection.

Try again after a few seconds; the server may have been temporarily unavailable.

https://www.xtractpler.com/


Backup / Restore Is Slow

Reading or writing 128 patches requires 128 individual SysEx transfers. This is normal — a full backup

typically takes 20–30 seconds. Do not disconnect the USB cable or switch patches on the device during the

transfer.

"Demo — 0 ops left" — I Have a License

Open the Activation window (⌘T / Ctrl+T) and check whether the license status shows as activated.

If it shows "Not Activated", re-enter your email and serial and click Activate.

Ensure you have an internet connection for the initial activation.

NovaEditor is developed independently and is not affiliated with or endorsed by Novation Music or its parent

company.

MiniNova is a trademark of Novation Music.


